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1 Einleitung

1.1 Orientierung

Dies ist das Benutzerhandbuch zum Bildbearbeitungsprogramm IntelliPhoto.
IntelliPhoto wurde im Wintersemester 19/20 im Rahmen eines die Vorlesung
Softwareengineering begleitenden Praktikums erstellt, in dessen Rahmen die
Teilnehmer erste Erfahrung in der Softwareentwicklung sammeln solten.

Dieses Dokument ist eine Einführung in den Umgang mit IntelliPhoto. Es
werden die benötigten System Voraussetzungen erläutert, die Funktionen
und deren Anwendungen präsentiert sowie im ’Troubleshooting’ Abschnitt
mögliche Fehler und der Umgang mit diesen aufgelistet. Ersteres stellt eine
Ergänzung zu README da. Das Manual enthält alle Informationen die be-
nötigt werden das Programm zu starten und die Grundfunktionen zu nutzen.

Dieses Dokument bietet keinen Überblick über Design, Implementation und
technische Details der Software. Informationen über diese Themen finden sich
im Programmierer-Handbuch zu IntelliPhoto.

1.2 Ziele

IntelliPhoto wurde mit dem Ziel entwickelt einen grafischen Editor zu erhal-
ten der in der Lage ist Bilder in einem 8-Bit Format zu bearbeiten, wir haben
dabei besonders darauf geachtet dass die 256 mit 8-Bit darstellbaren Farben
frei wählbar sind. Es soll dem Nutzer möglich sein neue Bilder zu erstellen
oder existierende zu öffnen. Im nächsten Schritt sollen diese Bearbeitet wer-
den indem Bereiche gefärbt, das Bild skaliert oder gedreht wird. Auch ein
Zusammenfügen zweier Bilder zu einem neuen soll möglich sein. Diese Ope-
rationen sollen in einer zumutbaren Zeit erfüllt werden, als obere Schranke
wurde 0,2 Sekunden ermittelt. Zusätzlich sollen sogenannte ’ShapedImages’
aus existierenden Bildern erstellt werden können. ShapedImages sind Bilder
in Form eines beliebigen Polygons.

Diese Funktionalitäten werden von IntelliPhoto allesamt implementiert. Zu-
sätzlich wurde eine Layer Struktur implementiert und dem Benutzer das
bewegen von Bildern in der Oberfläche ermöglicht. Leider hat das Programm
auch ein unangenehmes Problem, so ist Ästhetik ist aus Zeitgründen verbes-
serungswürdig geblieben. Als Resultat ist IntelliPhoto optisch wenig einla-
dend und in der Bedienung komplex. Eine Abhilfe zu letzterem Punkt ist
dieses Manual.
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2 Installation
Der Code wurde auf Linux Systemen entwickelt und ist mit Sicherheit auf die-
sen lauffähig. Er ist aber wahrscheinlich auch auf anderen Betriebssystemen
lauffähig. Nachdem Sie das Programm erhalten haben, entweder über den
Kontakt Professur Softwaretechnik der Tu Chemnitz, Softwareengineering
Praktikum WS 19/20 Gruppe 3 oder jeremias.piljug@s2017.tu-chemnitz.de
führen Sie unter einem Linux System einfach die in der README beschrei-
benen Schritte aus.
Bei Fragen oder Problemen wenden sie sich an einen der obigen Kontakte.

3 Bedienung
In diesem Abschnitt werden die Grundfunktionen von IntelliPhoto erklärt:

3.1 Startmenü

Nach dem starten der Anwendung öffnet sich das Grundmenü von Intelli-
Photo. Im oberen Teil des Menüs findet sich eine Reiterleiste von der aus auf
die verschiedene Funktionen zugegriffen werden kann. Am rechten Rand fin-
det sich eine Leiste in der später die verschiedenen Layer angezeigt werden.
Im unteren Teil findet sich der so genannte ’Colortable’. Beim Start enthält
dieser 21 Grundfarben, allgemein die 256 Farben die im derzeitigen Layer
verwendet werden. Unterhalb des Colortables ist die Statusleiste. Der Rest
des Bildes wird von der Arbeitsoberfläche eingenommen. In dieser werden
die Bilder angezeigt und bearbeitet.
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Colortable

Reiterleiste

Arbeitsfläche

Layer-Dock

Abbildung 1: IntelliPhoto Startmenü

Statusleiste

Abbildung 2: IntelliPhoto bei der Benutzung

Im folgenden werden die Funktionen näher geordnet. Die Reihenfolge wird
dabei durch die einzelnen Menüpunkte gegeben. Dabei wird als ’Layer’ im-
mer ein Element des Layer-Docks, also ein zusammenhängendes Subbild mit
eigener Colormap, bezeichnet. Als Bild werden alle angezeigten Layer in der
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Arbeitsfläche bezeichnet, also das was zu einem beliebigen Zeitpunkt in der
Arbeitsfläche zu sehen ist.

3.2 Arbeitsfläche

In der Arbeitsfläche wird das Bild, also die Gesamtheit aller Layer angezeigt.
Layer können hier auch bearbeitet werden. Es ist möglich durch anklicken
des aktuellen Layers, der dessen Hintergrund im Layer Dock grau hinterlegt
ist, und durch gedrückt halten der linken Maustaste diesen durch die Ar-
beitsfläche zu bewegen. Besteht das Bild aus zwei Layern die einander nicht
berühren so werden die Zwischenbereiche mit transparenten Pixeln gefüllt,
diese erscheinen in der Arbeitsfläche kariert. Auch Sperrpixel erscheinen so.

(a) Auseinander gezogene Layer (b) Layer mit Transparenz

Abbildung 3: Transparenz in der Arbeitsfläche

3.3 File

Nach Mausklick auf File fährt sich ein Reiter aus. Die Einträge dieses Reiters
sind die folgenden:

3.3.1 Open

IntelliPhoto ist in der Lage die gebräuchlichen Formate, insbesondere JPEG
und PNG zu öffnen. Ein Mausklick auf Open öffnet den File-Browser des
jeweiligen Betriebssystems. Wie gewohnt kann man in diesem ein Bild aus-
wählen. Nach Bestätigung wird es als Layer geladen und in der Arbeitsfläche
angezeigt. Zum laden wird die letzte unter ’New Layer’ ausgewählte Color-
map verwendet, default ist ’small’.
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3.3.2 Save As

Hier findet sich die Funktion zum Speichern des derzeitigen Zwischenstan-
des. Es wird ein File-Browser des jeweiligen Betriebssystem geöffnet in dem
Speicherort und Name ausgewählt werden können.
Achtung: IntelliPhoto speichert Bilder grundsätzlich im JPEG Format. Es
ist jedoch möglich anderer Formate auszuwählen. Dazu wähle unter ’Files of
type’ das gewünschte Format aus und ergänze bei ’File Name’ die korrespon-
dierende Dateiendung.
Achtung: ShapedImages sollten im Dateiformat ’.png’ gespeichert werden, da
dieses Transparenz unterstützt. Ein Konzept auf dem ShapedImage basiert.
Achtung: Es wird der gerade sichtbare Teil der Arbeitsfläche, also das Bild,
gespeichert. Möchte man einzelne Layer nicht mit speichern, entferne einfach
deren Haken, das Layer wird nicht länger angezeigt.

3.3.3 Exit

Beendet das Programm.

3.4 View

Nach Mausklick auf File fährt sich ein Reiter aus. Die Funktionen des Reiters
stehen nur zur Verfügung wenn mindestens ein Layer existiert, diese sind:

3.4.1 Zoom In/Out

’Zoom In’ vergrößert den Arbeitsflächen Ausschnitt. ’Zoom Out’ verkleinert
den Arbeitsflächen Ausschnitt.

3.4.2 Normal Size

Hebt alle Zooms auf.

3.5 Tools

Öffnet bei Mausklick einen Reiter, dieser enthält die Kernfunktionen von
IntelliPhoto. Eine nähere Erklärung zu diesen findet sich in den folgenden
Punkten.

3.5.1 Draw

Es wird ein Draw Dock geöffnet. Hier finden sich die Funktionen zum Zeich-
nen.
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Abbildung 4: Draw Dock

Die ausgewählte Draw-Funktion wird aktiviert indem man den Button ’Start’
drückt. Dieser wird dann grau unterlegt und zeigt ’Stop’ an. Man kann jetzt
auf dem aktuell ausgewählten Layer, dieses ist im Layer-Dock grau unterlegt,
zeichnen. Zum beenden der Funktion betätige den ’Stop’-Knopf. Die zur
Verfügung stehenden Draw-Funktionen sind:

- Pencil: Halte die linke Maustaste gedrückt um per Maus zu zeichnen

- Lines: Bewege die Maus zu einem beliebigen Punkt der Zeichenfläche.
Halte die linke Maustaste gedrückt, um zwischen Mausposition und
Startpunkt eine gerade Linie zu ziehen. Lasse die linke Maustaste los
um die Linie zu zeichnen.

- Filled polygon: Linksklick auf Punkte der Arbeitsoberfläche, diese
sind Ecken eines Polygons. Ab dem dritten Punkt werden die Bereiche
des Layers angemalt die im inneren des durch die angeklickten Punk-
te spezifizierten Polygons liegen. Rechtsklick zum bestätigen, ’Stop’
drücken zum verwerfen der Änderung.

- Inverse polygon: Analog zu ’Filled polygon’, zeichne diesmal aber
alle Bereiche außerhalb des spezifizierten Polygons.

Die anderen Elemente des Draw-Docks haben unterstützende Funktion:

- Color: Klappt die Colormap des Layers aus. Hier kann man eine Farbe
auswählen mit der gezeichnet werden soll.
Achtung: Auf dieser Weise werden ShapedImages erzeugt indem nach
setzen des MakeShaped Hakens das Sperrpixel (Farbe 255) ausgewählt
wird, insbesondere die Polygon Funktionen sind dazu nützlich.

- Ignore Shape: Zeichne in ShapedImages auch in Bereiche die mit
Sperrpixeln besetzt sind.
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- Width: Regler und Eingabefeld dienen zum einstellen der Strichdicke
bei ’Pencil’ und ’Lines’.

3.5.2 New Layer

Öffnet einen New Layer Dock, dieser bietet die Möglichkeit zum erstellen
neuer Bilder.

Abbildung 5: New Layer Dock

Durch Linksklick auf ’Add new layer’ wird ein neues einfarbiges Layer mit
den im New Layer Dock angegebenen Eigenschaften geladen, diese sind:

- Size-x/y: Stelle Breite (x) und Höhe (y) des neuen Layers ein. Maxi-
malwert ist jeweils 2000

- Color: Wähle die Farbe aus in der das neue Layer geladen werden soll.
Unter ’Existing’ kann eine in der aktuellen Colormap existierende Farbe
und unter ’New Color’ eine beliebig zu wählende Farbe ausgewählt
werden. Das erzeugt Layer hat diese Farbe.

- Colormap: Wähle die Colormap für das neue Layer. ’Current’ ist die
Colormap des aktuellen Layers einschließlich Nutzer spezifischer Ver-
änderungen (z.B Abb. 10 c), ’standart’ ist eine 256 Farben umfassende
Colormap (Abb. 10 b) und ’small’ ist die 21 Farben umfassende default
Colormap (Abb. 10 a).

Im default Zustand, also wie in Abb. 4, wird also ein weißes Layer der Größe
100×100 mit ’current Colormap’ erstellt.
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Die Einstellung Colormap wird zusätzlich benötigt um die Colormap ein-
zustellen mit der ein beliebiges Bild durch ’open’ geöffnet werden soll.
Achtung: Um ein Bild mit der ’standart’ Colormap zu öffnen ist es zunächst
notwendig einen New Layer Dock zu öffnen und ’standart’ auszuwählen.

3.5.3 Translate

Öffnet einen Translate Dock. Dieser stellt die Funktionen zum Drehen und
Skalieren von Bildern bereit.

Abbildung 6: Translate Dock

Linksklick auf ’Apply’ führt die oben angegebene Translation durch. Sind
keine Werte angegeben werden die jeweiligen default Werte verwendet:

- zoom-x/y: Skaliert die angegebene Richtung um den angegebenen
Wert. Defaultwert ist 1.

- rotate clockwise: Rotiert das Bild im Uhrzeigersinn um den angege-
benen Wert. Defaultwert ist 0.

- mirrored: Wird der Haken gesetzt wird zusätzlich eine Spiegelung an
der Hauptdiagonalen vorgenommen.

3.5.4 Make Shaped

Setzen Sie hier einen Haken wird das Bild zu einem ShapedImage. Für diese
steht das ’Sperrpixel’ (Farbe 255) zur Verfügung. Bildbereiche die mit diesem
Pixel belegt sind, sind voll transparent und können nicht mehr beschrieben
werden. Mit den Draw-Werkzeugen lassen sich durch Auswahl des Sperrpixels
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also Layern eine beliebige Formen geben.
Tipp: Die Draw-Polygon-Tools eigenen sich besonders gut um Layern schnell
eine beliebige Polygonform zu geben.
Achtung: Ist der Hacken für ’Make Shaped’ einmal gesetzt kann dieser nicht
mehr entfernt werden. Auch das Sperrpixel kann dann nicht mehr durch ein
anderes ersetzt werden.

Abbildung 7: ShapedImage mit InversePolygon erstellt

3.6 Help

Hier finden sich Informationen zu Qt, der zentralen Bibliothek für IntelliPho-
to. Auch findet sich hier eine kleine Vorstellung von IntelliPhoto sowie der
Kontakt zum Entwicklerteam.

3.7 Layers

Der Layer Dock bietet einen Überblick über die verschiedenen existierenden
Layer. Das aktuelle Layer, welches man beschreiben und bewegen kann, ist
dabei grau unterlegt. Mit Doppelklick auf ein anderes Layer wird dieses als
aktuelles Layer ausgewählt. Die Symbole haben die Bedeutung:

- ’+’ Zwischen zwei Layern fügt es die beiden Layer zu einem zusammen.
Es wird immer das untere auf das obere gelegt. Mehr dazu unter 3.6.1.
Das unterste und oberste erzeugt einen New Layer Dock.
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- Pfeile bewege angrenzende Layer hoch und runter. Die Position der
Layer im Dock entscheidet über die Reihenfolge in der die Layer ange-
zeigt werden. Das oberste Layer wir dabei zuunterst angezeigt. Layer
die tiefer im Dock stehen können also andere Layer überdecken.

- Haken: Ein gesetzter Haken bedeutet dass das Bild in der Arbeitsfläche
angezeigt wird. Der Haken ist beliebig setz- und entfernbar.

- ’-’ Löscht das Layer. Steht nicht für aktuelles Layer zur Verfügung.
Achtung: Existiert nur ein Layer ist dies automatisch das aktuelle.

Layer

aktuelles Layer
(grau)Zusammenfügen

Hoch/Runter

Anzeigen

New Layer
Dock

New Layer
Dock

Abbildung 8: Layer Dock bei zwei existierenden Layer

3.7.1 Zusammenfügen

Das ’+’ fügt wie schon gesagt die zwei anliegenden Layer zu einem neuen
Layer zusammen, indem es das untere auf das oberste legt. Die alten Layer
werden dabei gelöscht. Für das neue Layer wird die Colormap des oberen
Layers verwendet. Die Position der Layer zueinander ist also wichtig.
Achtung: gibt es bereiche der Arbeitsfläche die nur von einem der beiden
Layer überdeckt werden hat das neue Layer automatisch nicht mehr Rechteck
Form. Dadurch wird es von IntelliPhoto als ShapedImage betrachtet (Im
neuen Layer ist MakeShaped gesetzt).
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(a) Resultat ist kein ShapedImage (b) Resultat ist ShapedImage

Abbildung 9: Beispiele Zusammenfügen

3.8 Colortable

Hier findet der Nutzer die Farben die im derzeitigen Layer verwendet werden.
Die Anzahl ist auf 256 Farben beschränkt. Jeder Layer hat dabei seine eigene
Colormap. Transparente Farben in der Colormap werden kariert dargestellt.

(a) Small Colormap

(b) Standart Colormap

(c) Benutzer spezifische Colormap

Abbildung 10: Typische Colormaps

Per Mausklick auf ein Feld kann eine neue Farbe ausgewählt werden, die die
alte Farbe ersetzt. Nach dem Klick öffnet sich das folgende Menü zum Farbe
auswählen.
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Abbildung 11: Farbauswahl Menü

Dies ist ein Standard Farbmenü. Mit ’Alpha Channel’ lässt sich die Trans-
parenz einstellen.
Achtung: Wird eine Farbe in der Colormap durch eine andere ersetzt, so wir
die alte Farbe auch im Layer durch die neue ersetzt. Es kann also durch
ersetzten einer Farbe zu großen Veränderungen im aktuellen Layer kommen.

3.9 Statusleiste

In der Statusleiste werden Meldungen nach gewissen Operationen, zum Bei-
spiel öffnen, angezeigt.

3.9.1 Dimensionen abfragen

In der Statusleiste wird standardmäßig die Dimension des aktuellen Layers
angezeigt. Für ein ShapedImage ist der angegebene Wert als Dimension des
Bildes zu verstehen, aus dem das ShapedImage ausgeschnitten ist. Das For-
mat ist Breite×Höhe.
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3.10 Shortcuts

Folgende Keyboard Shortcuts stehen dem Nutzer zur Verfügung:

Funktion Tastenkombination
Open Strg+O
SaveAs Strg+S
Quit Strg+Q
Zoom In Strg++
Zoom Out Strg+-
Normal Size Strg+0
Draw Strg+D
New Layer Strg+N
Translate STrg+T

Wir haben uns bewusst dafür entschieden keinen Shortcut für ’MakeShaped’
zu definieren um ein Layer nicht aus Versehen Shaped zu machen. Das aktive
setzen des Hakens sorgt für einen bewussteren Bedienungsvorgang.

3.11 Anwendungsszenarien

Hier noch drei kurze Anwendungsszenarien die den Umgang mit IntelliPhoto
verdeutlichen sollen.

3.11.1 Beliebiges Bild mit Standard Colormap öffnen

Es wird angenommen dass das Programm soeben gestartet wurde und sich
im Startmenü befindet.
Öffnen sie einen New Layer Dock über Reiterleiste > Tools > New Layer
(oder ’Strg+N’). Wählen sie in diesem unter Colormap den Punkt ’standart’
aus. Öffnen sie ein beliebiges Bild auf ihrem Gerät über Reiterleiste > File
> Open (oder ’Strg+O’).

3.11.2 Shaped Image erstellen

Es wird angenommen dass dem Programm mindestens einen Layer hat und
dieser noch kein Shaped Image ist.
Setzten Sie unter Reiterleiste > Tools > Make Shaped den Haken. Anschlie-
ßend öffnen Sie einen Draw Dock unter Reiterleiste > Tools > Draw (oder
’Strg+D’). Wählen Sie im Draw Dock als Farbe das Sperrpixel unter der
Nummer 255 aus. Wählen sie jetzt ein beliebiges Draw-Tool, zum Beispiel
’Inverse Polygon’ aus und drücken ’Start’. Wollen sie zum Beispiel ein fünf
Eck erzeugen, Linksklick auf die Eckpunkte und Rechtsklick zum bestätigen.
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Drücken Sie anschließend ’Stop’.

(a) 3.11.1 (b) 3.11.2

Abbildung 12: Ergebnisse obiger Vorgänge

4 Troubleshooting
In diesem Abschnitt werden ein paar Probleme und Fehler angesprochen die
uns während der Benutzung passiert sind und sowie Wege diese zu vermeiden:

• Absturz nach Abbruch des Öffnen: Ist noch kein Layer geöffnet und
man klickt ’Open’ und beendet den sich öffnenden File-Browser ohne
ein Bild zu laden, so stürzt das Programm ab.

• Ein wiederholtes drehen eines Layers um einen betragsmäßig kleinen
Winkel führt zu einem sich wellenden Rand, dieser verkleinert das Bild.
Es wird empfohlen stattdessen einfach einmal um die Summe der Win-
kel zu drehen.

• Eine schnelles hintereinander ausführen von Translationen führt dazu
dass das alte Layer nicht mehr gelöscht wird

• Wird im Draw-Dock eine Draw-Funktion außer Pencil aktiviert und das
Dock anschließend geschlossen, so ist beim erneuten öffnen des Draw-
Docks zwar Pencil ausgewählt, die vorherige aktivierte Draw-Funktion
ist aber weiter aktiv. Ein Klick auf ’Stopp’ setzt das zurück

Sollten Ihnen während der Nutzung andere Fehler, Fragen oder Probleme be-
gegnen, kontaktieren sie die Gruppe 3, Softwareengineering Praktikum WS
19/20 der Professur Softwaretechnik an der TU Chemnitz.
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In diesem Sinne viel Spaß mit dem Programm,

Pascal Schröter, Jeremias Piljug, Dongze Yang und Xiangyu Tong

Gruppe 3

16


